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Introduction 

Microsoft Excel: Excel Basics 

Excel is a program in the Microsoft Office system. Excel is used to create, format, edit, 

and print workbooks, which are collections of spreadsheets. Spreadsheets are used by 

professionals in many  occupations to collect and analyze data. A user can perform 

calculations based on the data as well as convert the data to charts, tables, and other 

display formats.  

This guide refers to the desktop version of Excel in Windows. 

Topics covered include: 

• Excel’s layout (i.e. what does an Excel workbook look like?)

• Entering, editing, and formatting data

• Excel’s basic functions (i.e. what can we do with Excel?)

• Sorting data

• Formulas and functions

• Creating charts and graphs from data

Section 1: Opening Excel 

There are two different ways to open Excel on your computer: 

1. Find the Excel icon on your desktop, or wherever you have Excel stored. It will look like Figure 1.

Double-click on the icon; or alternately, right-click on the icon and choose “Open” from the drop-down

menu by clicking once.

2. Click on the “Start” icon in the bottom-left corner of your screen. Scroll down the alphabetical list in the

menu and double-click on Excel.

Once opened, the home screen looks something like Figure 2: 

Choose “Blank Workbook” (Figure 3) from 

the menu to open a new workbook in Excel. 

Fig. 1 

Fig. 3 
Fig. 2 
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Section 2: The Parts of the Excel Workbook 

Below the title bar are the tabs (Figure 6). 

Underneath tabs is the toolbar (also sometimes called the “ribbon”). See Figure 7. 

The toolbar contains the various features (i.e “tools”) of Excel that you use to edit your workbook. If you hover over a feature in 

the toolbar with your mouse, a small window will show on the screen with a description of what that feature does.  

By using the tabs, you can choose which types of tools to use. Each tab is themed: “File,” “Home,” Insert,” “Page Layout,” 

“Formulas,”  “Data,” “Review,” and “View.”  When you click on any of the tabs, the toolbar changes appearance. “Home” is the 

default tab; the tools in the “Home” tab are the ones most commonly used. 

Familiarize yourself with the tabs and the toolbar features. Note what happens when you hover over the tools in the toolbar, 

and how the toolbar changes when you change tabs. 

A blank Excel workbook should look something like Figure 4. At the top of the screen is the title bar. (Figure 5) 

The title bar displays the name of the workbook. When you open a blank Excel workbook, the default name is “Book1.” To 

change this, click on the  “File” tab at the top left and choose “Save As” from the drop-down menu. A navigation window 

should appear; it contains a highlighted section that displays the name of the workbook. Type a new name for the workbook 

here. Choose the location where you want to store the workbook from the menu of locations on the left side of the navigation 

window. Click “Save.” The title bar will change to reflect the name you have given the workbook. 

Fig. 5 

Title bar 

Tabs 

Toolbar 

Formula 

bar 
Spreadsheet 

Fig. 4 

Fig. 7 

Fig. 6 
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Below the toolbar you’ll see the formula bar, a long, blank field at the top of the spreadsheet. See Figure 8. 

When you enter data in Excel, what you type will display in the formula bar unless you’re using a formula, in which case that 

formula will appear in the bar. 

Underneath the formula bar is the spreadsheet itself, which takes up most of the screen. See Figure 9. 

The spreadsheet is divided into a large 

grid of blank rectangles, called cells.  

To enter data into the spreadsheet  

you must select a cell. The selected cell 

is called the active cell; it  will be  

highlighted by a darker border.  

Once the cell has been selected, you can 

type data into it.  

There are numbers on the left side of the spreadsheet and letters on top of it; these characters 

are used to name the coordinates of the cells. Letters name the columns, numbers name the 

rows. Columns are vertical (up and down). Rows are horizontal (left and right). 

Each cell in a workbook has its own unique name. The first cell in the top left occupies a place in column A and a place in row 1. 

A cell’s name is its column letter first and its row number second; therefore that first cell in the top left is cell A1.The next cell,  

going downward, would be cell A2, and so on.  

Directly over column A and to the left of the formula bar is the name box, which displays 

the name of the active cell. In Figure 13, cell A1 is the active cell, so the name box says 

A1. Click on any cell in the workbook and the name box will display its name. 

Name box 

Fig. 13 

Fig. 8 

Columns 

Rows 

Fig. 9 

Drag to resize the 

selected rows. 

Fig. 11 

Fig. 10 

If you place the cursor on the border between any of the columns (at the top 

where their corresponding letters are), the cursor will resemble a small vertical line 

with two arrows emerging from its left and right sides (see Figure 10). Clicking and 

dragging to the left or right will widen or narrow your columns as needed.  

You can also widen or narrow the rows using the same method (see Figure 11). 

Fig. 12 

Tip: A cell filled with pound signs (see Figure 12), is an indication 

that the cell is too narrow for the data in it. Place the cursor on 

the border between that cell’s column and the one next to it  

(as in Figure 10) and drag to make the column wider. 
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When a cell is active, you can type letters, numbers, and other characters into it. There are two ways to do this: directly in the cell 

or using the formula bar. 

Section 3: Entering Data in Cells 

In Figure 14, cell A1 is the active cell. The thicker border surrounds cell A1, and the 

name of the cell in the name box reads “A1”. Make cell A1 your active cell and type the 

number 23. Do not press “Enter” on the keyboard yet. 

Fig. 15 Note how the data appear in cell A1 (Figure 15). The cursor is a vertical line and data 

appear to the left of it.  Now press the “Enter” key. 

Pressing the “Enter” key on the keyboard moves the data in cell A1 (the value 

of 23) from the left side of the cell to the right side, and changes the active cell 

from A1 to A2 (see Figure 16).  

A2 is now in the name box, a thicker border highlights cell A2 and there is no 

cursor in cell A1 anymore, meaning data cannot be entered into cell A1 unless 

it is made active again. 

The formula bar is the long, blank, open field between the toolbar and the row of 

letters on top of the spreadsheet (Figure 17). Any data entered into a cell will appear 

in the formula bar while that cell is active.  

Click on cell A1, which contains the value of 23, to make it active again. The value of 

23 should appear in the formula bar, too (Figure 18). 

Similarly, if you type data into the formula bar, the data will appear in any cell that is active. 

For example, click on cell A2 to make it active. Because there is no 

value or data in that cell, both the cell and the formula bar are blank, 

as shown in Figure 19. 

Place your cursor into the formula bar, type “23,” then press the 

“Enter” key on the keyboard. The value “23” should appear in cell A2 

(Figure 20).  

(An actual formula entered into a spreadsheet’s cell will  

appear as a formula in the formula bar, but will display the formula’s 

result in that cell after pressing the “Enter”  key. Stay tuned.) 

Active cell 

Formula Bar 

Fig. 18 

Fig. 14 

Formula Bar 

Fig. 17 

Fig. 16 

Fig. 19 

Fig. 20 
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If you want to delete data in a cell, right-click on the cell to open a drop-

down menu, and choose the “Clear Contents” option (Figure 21).  

“Clearing” the contents of a cell is more effective than highlighting a cell 

and then pressing the “Backspace” key on the keyboard; deleting the cell 

won’t necessarily delete any formulas embedded in that cell (more on  

formulas later). “Clear contents” immediately deletes any data and any  

formulas that may exist in that cell.  

Moving from Cell to Cell 

To move from an active cell to the next cell to its right, you can: 

1. Press the “Tab” key on your keyboard

2. Press the arrow key on your keyboard pointing to the right (It will look like this: >)

3. Use the mouse to click on the cell to the immediate right of the active cell.

To move from an active cell to any other adjacent cell, use the arrow keys or the mouse. 

Section 4: Creating a Basic Spreadsheet 

Let’s create a spreadsheet that displays monthly expenses from January through April of a random year. 

First, clear all cells of any contents. 

In row 2, type the names of the months from January to April in order, beginning with cell B2 and continuing through cell E2. 

Leave the top row—row 1—blank. 

After entering the name of each month, press the “Tab” key on the keyboard to move to the next cell. 

The end result should look like Figure 22: 

In column A, enter the names of expenses: “Food,” “Gas,” “Internet,” and “Electricity.”  Begin with cell A3, then A4, A5, and A6. 

Leave A2 blank. Now the spreadsheet should look like Figure 23.  

The top row should be blank 

Fig. 22 

Fig. 21 

Fig. 23 



West Chicago Public Library: Microsoft Excel: Basic Excel Skills 6

Please open the document called “Monthly expenses practice” that is saved on your desktop; this is the same spreadsheet 

but with expense amounts added. In January, we spent $237.64 on food, in February, we spent $251.12 on food, and so on. 

The spreadsheet should look like Figure 24. 

Before we do any calculations, we’re going to format some of the data. On the top row of the spreadsheet—row 1—we will give 

the table a name and center the name on top of the table.  

Click on cell A1 to make it active. Then type in the words “Monthly Expenses.” The words will spill over from cell A1 into cell B1, as 

shown in Figure 25. 

Now, click on cell A1, hold down the left mouse button and move (“drag”) the mouse to the right, until you’ve selected the top 

row from column A through column E. It should look like Figure 26: 

Next, find the “Merge & Center” tool in the toolbar (see Figure 27) and click on it. It should be in the “Home” tab, near the center 

of the toolbar. 

Fig. 24 

Fig. 25 

Fig. 26 

Fig. 27 
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The words “Monthly Expenses” should now be centered over the table, and the borders between the cells in row 1, 

between column A and column E, should be erased. It should look like Figure 28: 

By “Merging” and “Centering,” we have combined the cells A1 through E1 into one long cell and centered the text in that cell. Now 

cell A1 is ALL of the cells in the range A1 to E1; they have been merged successfully.  

Changing the color of the text and the cells can make data 

stand out more. While cell A1 is still active, find the text color 

tool in the toolbar (circled in red in Figure 29) and click on the 

small, downward-pointing arrow to the immediate right of the 

letter “A” to open a drop-down menu that looks like Figure 30. 

Choose the red option from the array of “Standard colors.” Now the words 

“Monthly Expenses” are red.  

To the left of the font color tool is the fill color tool (circled in green in Figure 29). 

Click on the small, downward-pointing arrow to the immediate right of the pouring 

paint can in the fill color tool to open a drop-down menu like the one in Figure 30. 

Changing fill and font colors can make data easier to read. Try out some different 

colors to see what you like. 

Next, click on cell B3, hold the left mouse button down and drag the mouse 

downward and to the right until you have selected every cell that contains 

a numeric value (cells B3 through E6). It should look like Figure 31. 

In the toolbar, find the “Number” section in the “Home” tab and click on the small,  

downward-pointing arrow to the immediate right of the word “General” (Figure 32). 

Choose “Currency” from the drop-down menu. 

Now the numeric values appear as currency, 

including dollar signs (Figure 33). 

Fig. 30 

Fig. 31 

Fig. 28 

Fig. 29 

Fig. 32 

Fig. 33 
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Fig. 34 

Section 5: Multiple Spreadsheets in the Same Workbook 

At the bottom left of your workbook, there is a tab marked “Sheet 1” and a “plus” (+) symbol (circled below in Figure 34). 

Clicking the “plus” symbol creates an additional spreadsheet in the workbook. Using multiple spreadsheets in the same workbook 

makes it easier to organize data. For example, you can use the first sheet to enter accounting or expense data for January of the 

current year, then use another sheet for February, one for March, etc.  

To change Sheet 1’s name, right-click on its tab, choose “Rename” 

from the drop-down menu (Figure 36), and type “January”.  

See Figure 37. 

Fig. 35 

Fig. 36 

Now rename Sheet 2 “February,” add another spreadsheet (Sheet 3) and rename it “March,” and so on. 

Fig. 37 

After clicking the “plus” symbol, the new spreadsheet, called 

“Sheet 2,” opens to the right of Sheet 1 (Figure 35). All data 

entered in Sheet 1 will stay in Sheet 1, new data can be  

entered in Sheet 2. 
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Section 6:  Sorting Data 

Sorting data can be useful—and sometimes necessary—in workbooks that contain a large amount of data. 

To begin, open a new spreadsheet using the “plus” symbol at the bottom of the workbook.  

Enter the following values: 42; 7; 3462; 40096; 47; 0.71 in cells A1-A6, respectively, as shown in Figure 38. 

Fig. 38 

There should be six cells, each with its own value, in the order listed above. Select cells 

A1 through A6 by clicking and dragging, as shown in Figure 39.  

Click on the “Data” tab and look at the “Sort & Filter” section in the middle of its 

toolbar (Figure 40). 

Fig. 39 Sort Smallest 

to Largest 

Fig. 40 

Click on the tool that sorts from smallest to largest (see Figure 41) and notice how 

that changes the order of the values in cells A1 through A6. (Figure 42).  

Now the smallest value in the range is in cell A1 and the largest is in cell A6.  

Sorting in the other direction—i.e. largest to smallest—will have the opposite effect. 

Sorting non-numeric text works the same way; Excel will sort data according to the 

initial letter in each cell, with A being the smallest value and Z being the largest. Fig. 42 

Fig. 41 

Sort Largest 

to Smallest 

Sort Smallest 

to Largest 

Fig. 43 

Note: If you have multiple columns of values and you 

arrange a single column by sorting it from smallest to 

largest (or vice-versa), Excel will display a “Sort  

Warning” dialog box (see Figure 43).  

If you keep the default “Expand the selection” option 

and click the “Sort” button, Excel will re-arrange ALL of 

the data according to the sorting scheme of that single 

column. 
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Excel is programmed to notice patterns, and intuit sequences. Using the “fill series” tool is helpful when entering data in a known 

sequence, like days of the week. Open a new spreadsheet using the “plus” sign at the bottom of the page. Click on cell A1 to make 

it active and type the word “Monday.” 

Fill Series 

When a cell is active, there is a small square on the bottom right corner of the cell 

called the fill handle. See Figure 44.  

Move the mouse over the fill handle until the cursor changes to a small, black cross, 

as shown in Figure 45.  

While the cursor looks like a black cross, you can click and drag cells vertically or 

horizontally to “fill” a range of cells with a specific sequence. 

In this example, click on the fill handle in cell A1, hold down the left mouse button, 

and drag the mouse to the right, through column H.  

Fig. 44 
Fig. 45 

Now Row 1 shows the 

days of the week, each in 

its own cell and in order 

(Figure 46).  

“Monday” is in cell A1, 

“Tuesday” in B1, etc.  

Fig. 46 

Section 7: A couple of cool tools 

Freezing Panes 

In a large spreadsheet, it’s helpful to see column (or row) headings when scrolling through the data. To keep headings visible: 

1. Go to the “View” menu.

2. Click on the downward-pointing arrow next to the “Freeze Panes” tool (see Figure 47).

3. In Figure 47’s example, choose “Freeze Top Row” to keep the column headings (“Day,” “Date,” “Eating Out,” etc.) visible. If

column headings are not in the top row, click on the row below the column headings and click “Freeze Panes” to keep column

headings visible.

Fig. 47 
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Section 8: Formulas and Functions 

Excel uses formulas and functions to calculate, analyze, and modify data. 

Excel requires that the user “speak Excel’s language” to properly create  formulas and produce desired results. For example, to 

calculate the sum of two values in Excel, the user must place values in appropriate cells, write an addition formula, and know how 

to read and use the formula bar. 

Every formula requires a function. Functions are essentially math operations; basic functions are used to find sums, differences, 

products, and quotients. With basic math operations, an explicit function is not always necessary, but with more complicated  

calculations, functions need to be set up in Excel-specific terms. 

Every Excel formula follows a common basic structure: 

=function(1st value; mathematical operator; 2nd value) 

Fig. 50 

Important details about formulas in Excel: 

1. EVERY formula begins with an equals sign (“=“).

2. The values in a specific formula must be expressed in terms of their cell names. If the value in cell A1 is 23 and the value in cell

A2 is 48, we will tell Excel to calculate the SUM of A1 and A2, not the sum of 23 and 48.

3. Many basic formulas in Excel can be expressed in a number of slightly different ways.

Simple Formulas Using the Four Basic Math Functions 

Addition, subtraction, multiplication, and division are the four basic math 

functions. With each of these, the user can write a streamlined formula 

for simple calculations.  

The structure of this formula remains consistent and uniform, but the 

math operator between the two values will change. 

Figure 48 displays four formulas for basic math problems.  

Fig. 48 

ADDITION: =(A1+A2) 

SUBTRACTION: =(A2-A1) 

MULTIPLICATION: =(A1*A2) 

DIVISION: =(A2/A1) 

ADDITION: Please enter the number 23 in cell A1 and 48 in cell A2.  To 

add the two values, type the following formula: =(A1+A2) into cell A3,  

as displayed in Figure 49. 

When using this formula structure, Excel will place colored borders 

around the cells being used. Before pressing “Enter,” the formula  

appears in both cell A3 and the formula bar. 

After pressing “Enter,” cell A3 displays the result of the formula, (i.e., the 

sum of the values in cells A1 and A2) and the formula itself in the formula 

bar (Figure 50).  

The simple formula structure used in Figures 49 and 50 does not require 

a function (e.g., the word “SUM”) between the equals sign and the open 

parenthesis. The mathematical operator “+” indicates the function. 

Fig. 49 
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Remember to right-click on cell A3 and clear its contents before re-writing formulas. 

SUBTRACTION: Figure 51 shows the same type of formula structure used to find the sum 

of the values in cells A1 and A2, only this time we are finding the difference between cell 

A2 and cell A1. (If we were to subtract the value in cell A2 from the value in cell A1, we 

would end up with a negative number.) Note that the plus sign (“+) is now a minus sign 

(“-”) but otherwise the formula structure is the same . 

Fig. 51 

Figure 52 shows the difference between 48 and 23: 25. Again, cell A3 displays 

the result of the formula and the formula bar displays the formula itself. 

Fig. 52 

MULTIPLICATION: Figure 53 shows the same formula structure in cell A3 that was 

used in the previous examples. In Excel, the multiplication operator is an asterisk 

(“*”). Write the same formula structure in cell A3, but replace the plus sign and the 

minus sign with an asterisk to multiply the values in cells A1 and A2. 

Figure 54 shows the product of multiplying 48 and 23: 1104. The formula is 

displayed in the formula bar. 

Fig. 53 

Fig. 54 

DIVISION: Figure 55 shows the correct way of writing a simple division equation to 

find the quotient of 48 and 23. Division uses a slash (“/”) as its operator. Like the 

subtraction formula, we will divide cell A2 by cell A1 so that the larger number 

will be divided by the smaller. 

Fig. 55 

Figure 56 shows the quotient of dividing 48 by 23: 2.086957. Answers with 

remainders will be expressed as decimals. 

Fig. 56 
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Fig. 57 

Right-click on cell A3 and clear its contents. 

Enter the value of 51 in cell A3, 46 in cell A4, and 452 in cell A5, as shown in Figure 57. 

To find the sum of all five values, make cell A6 the active cell and then write the 

formula shown in Figure 57: =SUM(A1:A5) . 

Note that the function (“SUM”) directly follows the equals sign (“=“) in the formula. 

Between the two parentheses, there are two cells named: A1 and A5. To find the sum 

of ALL the values between cells A1 and A5, we could write a formula like this:  

 =SUM(A1+A2+A3+A4+A5), but that structure is time-consuming and unnecessary. 

Therefore, Excel uses the colon to show a range of cell names. When expressed in 

Excel, the range of values between cell A1 and cell A5 looks like this: (A1:A5). The 

colon is shorthand for all of the values/cell names between A1 and A5.  

Figure 58 shows the sum of all five values: 620. As always, the formula bar shows 

the formula behind the value shown in cell A6, whereas cell A6 shows the final 

result of that formula. 

More About Functions 

Stating the function in the formula is necessary with most functions. 

For example, to find the average of the same range of numbers, we 

use the same structure we used in Figure 57, but instead of “SUM,” 

we’ll use “AVERAGE.” Figure 59 shows how to write this formula in 

cell A7: 

Equals sign (“=“) followed by function (in this case, 

“AVERAGE”), followed by open parenthesis (“(“) followed 

by first cell in the range (“A1”), then the colon (denoting 

range—”:”), then finally, the end cell in the range (“A6”), 

and the closed parenthesis (“)”).  

This structure will be used with most formulas in Excel except the 

very basic math formulas in Figures 49-56 (pages 11-12). 

Figure 60 shows the result after pressing “Enter” on the keyboard. 

The average in the range of numbers between cell A1 and cell A6 is 

206.6667. 

The Colon in Excel Formulas 

Fig. 58 

Fig. 60 

Fig. 59 
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You can also use this structure to find the smallest (“MIN”) and largest 

(“MAX”)  values in a range of cells. Replace “AVERAGE” with “MIN” and 

“MAX” to find those values. See Figures 61-64. 

AutoSum 

AutoSum is a useful tool with ranges of numbers.  

Make active (click on) a cell at the end of a range of numbers. 

From the “Home” tab, click the AutoSum tool (Figure 65). Excel will 

automatically add all the numbers in that range.  

Options for AVERAGE, MIN, and MAX are also available in AutoSum’s 

drop-down menu. 

Fig. 61 Fig. 62 

Fig. 63 Fig. 64 

Fig. 65 
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Section 9: Charts and Graphs 
Return to the “Monthly Expenses” table from Figure 33 on page 7. It should still be in the “Sheet1” spreadsheet at the bottom of 

the practice workbook.  

To convert this table to a chart or graph, first select all the data, 

INCLUDING the expense and month labels, as shown in Fig. 66. 

(You do not need to include the “Monthly Expenses” header in 

cell A1.) 

Hover over any of the symbols in that section to reveal the available 

charts and graphs. Choose the “Column or Bar Chart” feature, which 

looks like a small bar chart (Figure 68). 

Next, choose the “Insert” tab in the toolbar and look at 

the section labelled “Charts” (see Figure 67). 

Fig. 67 

From the  drop-down 

menu of options (Figure 

69), choose the first one: 

2-D Columns.

Now the data in the table has been converted to a simple bar 

graph, complete with expense and month labels and  

different colors to make the data easier to read (Figure 70). 

Congratulations! You have just completed Microsoft Excel 2016: Basic Excel Skills.  

To learn more advanced Excel skills, please try ouran educational databases offered by the Library. 

Step 1: Go to the West Chicago Public Library’s website: wcpld.info. 

Step 2: Move your mouse over the heading “Digital Library” and click on “Research Databases and Resources”. 

Step 3: Scroll down the alphabetical list of databases and explore what we have to offer!

Step 4: Sign in with your library card number and PIN.  

Fig. 68 

Fig. 69 

Fig. 70 

Fig. 66 




